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Learning Objectives 

• Utilize schedules to perform energy code calculations 

• Utilize schedules to better coordinate electrical circuitry with mechanical and plumbing loads 

• Utilize schedules to check electrical design at the panel and breaker level 

• Utilize view filters to catch uncircuited electrical items as well as other disciplines that require 

power 

 

Description 
This class will discuss and present ways to more effectively utilize REVIT for electrical design by better 

utilizing the data already in the model to perform calculations and checks. Rather than spending days 

working on the energy code calculation counting the fixtures and space square footages, imagine if you 

could print out a REVIT schedule with all the information needed to fill out COMCheck in a matter of 

minutes. REVIT can also be used to help the senior engineers and the QA/QC teams quickly to check the 

electrical backbone of a building for things like over and under-loading of electrical panels/transformers 

as well as branch circuit loading to check breaker size, wire size, and load classification with all the 

information exactly as it is currently modeled. A series of schedules can also compare the current 

Mechanical/plumbing schedules with the current electrical design load to ensure they match. Filters can 

be used to check for uncircuited items as a quick backcheck. 
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Your AU Expert 

 
 

Stephanie P. Elliott, PE, LEED AP BD+C, GGP is a licensed electrical engineer for Jacobs Engineering 

Group Inc. She is a LEED AP BD+C and a Green Globes Professional. She is a Revit MEP 2015 Certified 

Professional and serves a dual role as the Houston office Building Information Modeling (BIM) 

coordinator as well as being an electrical engineer. She has been working in Revit software since 2007 

and has experience with Revit software-based projects in many areas, including aviation, convention 

centers, data centers, education, federal, high-rise office towers, hospitality, and specialty facilities. 

Stephanie has served as an MEP BIM consultant for Revit projects that span 1 million square feet, as well 

as for campus projects with a central plant. 

 

Email: stephaniepelliott@gmail.com
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Introduction 

 
According to Autodesk, Revit is building design software is specifically built for Building 

Information Modeling (BIM), including features for architectural design, MEP and structural 

engineering, and construction.   

Autodesk purchased the Revit idea in 2006 and starting around 2010 architectural firms started 

to prefer to perform design work in REVIT even if the final deliverable was ACAD.   Why? 

Architects had figured out how to utilize the information in the model to their advantage, to 

improve their efficiency, coordination and design.  The same this is possible for the MEP team 

as well.  We are able to use the Revit model to improve our designs and coordination as well.   

As Engineers and Designers, we have to have a mindset shift from ACAD to Revit.  Our thinking 

has to shift from ACAD which is a drafting tool only to REVIT which is a database that does some 

drafting on the side.  

 

Utilize schedules to perform energy code calculations 

Determining when to perform the take-offs and fixture counts needed for the energy code 

is a tight rope walk.  Too early and the lighting design will change substantially and the 

effort will be wasted.  Too late and it is difficult to react to energy code concerns and still 

make the deadline.   

How We Use to Perform Energy Code Calculations?  

Energy code calculations were never a quick and simple task.  We used to have to open ACAD and draw 

Polylines (P-Lines) around each space and do hand area take-offs.  We then had to transfer that data to 

Excel.  Next we would grab out highlighters and print out the light drawings full size and hand-count all 

of the fixtures per space and then input those counts into our spreadsheet.  If we were lucky then we 

could fill out the energy code form as the whole building method and save ourselves some time.   

How We Can Use REVIT to Perform Energy Code Calculations 

Using Schedules in Revit, we can go from spending hours/days counting fixtures in order to report on 

whether a project meets the energy code to real time reporting at any phase of the design.  Imagine the 

time and rework savings being able to continuously monitor energy code status on a project!  So how do 

we set up our projects to achieve this? 

Step1: Create Spaces based off the Architectural Rooms 

In order for our energy code calculation to work, all of the light fixtures in the model need to 

inherently know what space they reside in. We achieve this by placing spaces in the electrical 

model.  An important thing to understand is the difference between Rooms and Spaces in Revit.  

Rooms are used predominately on the Architecture side of things to address things like Room 

Name, Number, Square Footage, and Occupancy.  Spaces are used for MEP calculations 

requiring volume information.  A space understands in which room of a linked model it resides, 

and it can report the identity of that room.  

To add spaces to the Electrical Model,  
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Go the Analyze tab and select the Space Button on the Spaces & Zones panel 

 

 This will trigger the Modify/Place Space Panel.  Check the Upper Limit Setting and Offset Values.  

The Upper Limit value is Z axis value for the space volume.  The Offset Value is an additional 

adder to the Upper Limit Value if needed.  For MEP work the recommendation is to use the 

Level Datums i.e. Upper Limiting Settings to define the height of the space to ensure the entire 

volume between structural slabs is accounted for.   

Once the Upper Limit and Offset have been set, select the Place Spaces Automatically Button  

  

Revit will then create spaces for all enclosed areas greater than 0.25 sq. ft. Revit will arbitrarily 

name and number all of the spaces.  This is where the space naming utility comes into play.  The 

Space Naming Utility Revit automatically renames spaces to match their associated rooms.  This 
plug-in is typically part of the Autodesk Subscription package.   

Step 2: Create a Room Schedule and define Space Type 

1. Go to the view tab and select “Schedules” under the create pane or right click on Schedules on 

the project browser.   

2. Select “New Schedule/ Quantities” 

3. Under category select “Rooms” 

4. Select the following Available Field and click Add�: 

a. Number 

b. Name 

c. Limit Offset 

d. Space Type 

e. Actual Lighting Load 

f. Actual Lighting Load per Area 
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g. Specified Lighting Load 

h. Specified Lighting Load Per Area 

5. If energy code will be achieved via space by space method, then go room by room and define 

the space category to be applied.  

6. Go back to Visibility/Graphics Override window, on the Fields tab, create some calculated values 

to help with the calculations.  Select Calculated Value button. 

a. Above LPD Allowance 

i. Name: Above LPD Allowance 

ii. Discipline: Common 

iii. Type: Number 

iv. Formula: Actual Lighting Load / Specified Lighting Load 

b. Square Footage 

i. Name: Square Footage 

ii. Discipline: Common 

iii. Type: Area 

iv. Formula: Specified Lighting Load / Specified Lighting Load per area 

7. On the Sorting/Grouping tab, sort by Name or Number, whichever you prefer 

8. At the bottom of the Sorting/Grouping tab, check the box for Grand Totals and select Title and 

Totals.  

9. Click on the Formatting tab, select the following parameters and check the Hidden check box 

a. Square Footage 

b. Above LPD Allowance 

10. Select Actual Lighting Load and then click on the Conditional Formatting Field to create the test 

to determine if the lighting layout in the room exceeds the energy code allowance. 

11. Select the following: 

a. Field: Above LPD Allowance 

b. Test: Greater Than 

c. Value: 1 

d. Background Color: Yellow 

12. Select Actual Lighting Load per Area and repeat Step 10.  
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This gives a snap shot of spaces that exceed their energy code allowance as well as the grand totals at 

the bottom to verify if we are able to trade Wattage allowances between spaces to meet the energy 

code overall.  

Step 3: Create a COMCheck Schedule  

1. Go to the view tab and select “Schedules” under the create pane or right click on Schedules on 

the project browser.   

2. Select “New Schedule/ Quantities” 

3. Under category select “ Light Fixtures” 

4. Select the following Available Field and click Add�: 

a. Type Mark 

b. Manufacturer 

c. Lamp 

d. Lamp Quantity 

e. Wattage 

f. Count 

g. Change the Select available Fields to Spaces and select Space Type 

h. Cove Fixture Count (user added parameter to family that takes the length value and 

divides it by a fixed off the shelf fixture length value) 

5. Still on the Fields tab, create some calculated values to help with the calculations.  Select 

Calculated Value button. 

a. Wattage Per Type 

i. Name: Wattage Per Type 
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ii. Discipline: Common 

iii. Type: Number 

iv. Formula: Lamp Quantity * (Wattage / 1 W) 

b. Count Manual 

i. Name: Count Manual 

ii. Discipline: Common 

iii. Type: Number 

iv. Formula: 1 

c. Cove WholeNumber 

i. Name: Cove WholeNumberl 

ii. Discipline: Common 

iii. Type: Number 

iv. Formula: roundup(Cove Fixture Count) 

d. Combined Count 

i. Name: Combined Count 

ii. Discipline: Common 

iii. Type: Number 

iv. Formula: if(Cove Fixture Count > 1, CoveWholeNumber, CountManual) 

6. On the Sorting/Grouping tab, sort by Space Type and then Type Mark. 

7. At the bottom of the Sorting/Grouping tab, check the box for Grand Totals and select Title and 

Totals.  

8. Uncheck the itemize every instance checkbox.  

9. Under the Formatting tab, check the calculate totals check box for the following fields:  

a. CountManual 

b. Cove Fixture Count 

c. Cove WholeNumber 

d. Combined Count 
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Utilize schedules to better coordinate electrical circuitry with 

mechanical and plumbing loads 
  

Creating schedules to help with the coordination between electrical and Mechanical and Plumbing   is a 

little more difficult because to be able to use the data in their schedules the parameters have to be set 

up in such a way that we are able to pull the data across the link and incorporate it into our schedules.   

 

First thing is to import Mechanical and Plumbing schedules in to the Electrical Model.  

1. Go to a floor plan view.  Click on the insert tab and select Insert from File on the Import Pane.  

2. Navigate to and select the Mechanical Model.   

3. Select all of the mechanical equipment schedules requiring electrical power and click import.   

4. Open each of the imported schedules and check the box Include Elements in Links.  

 

Next, create an electrical circuit schedule that isolates the mechanical and/or plumbing loads.   
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Another way that we can improve our coordination between the Mechanical/Plumbing Team and 

Electrical team is as follows:  

 

First, copy monitor the mechanical equipment into the electrical model using the type Mapping setting 

under the Collaborate Tab, Copy/Monitor, Select Link, Coordination Setting.  

 

Under Coordination Settings, Select Mechanical Equipment  and change the Mapping Behavior from 

Copy Original to Type Mapping.   

 

 
 

The following screen will pop up.  Select the family in the Electrical Model that you would like to be used 

for the copy/monitoring.  This family must be classified as mechanical equipment in order to be able to 

be selected for the monitoring. 

 

 
 

I use an electrical connection symbol.  
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Next create a mechanical equipment schedule with the following fields:  Mark, Count, and Horsepower 

field.  It is important that the family instance mark field is named exactly the same in the mechanical and 

electrical model.  Under the fields tab, select the include elements in links.  Under the sorting/ grouping 

tab, do not itemize every instance.   This will give us a schedule as follows.   The count field should be 2 

meaning there is an instance in both the electrical model and the mechanical model.  If the horsepower 

field matches in both instances then the horsepower filed will be populated.  If not then it will be blank.  
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Utilize schedules to check electrical design at the panel and breaker 

level 
Revit is so much more than just a drafting tool.  We are able to create circuits that actually connect the 

electrical load to an electrical equipment panel. We need to have a mindset shift to thinking of Revit as a 

database and as such what are the ways we can manipulate the data to our advantage.  If we are indeed 
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connecting the loads to the panels, then we should be able to also present the same data in a format 

that will allow us to verify the loadings of the electrical equipment. 

 We can use schedules to view the loading on our panels. 

Creating a New Panelboard Loading Schedule 

10. Go to the view tab and select “Schedules” under the create pane or right click on Schedules on 

the project browser.   

11. Select “New Schedule/ Quantities” 

12. Under category select “ Electrical Equipment” 

13. Select the following Available Field and click Add�: 

a. Panel Name 

b. Total Connected 

c. Total Connected Current 

d. Total Estimated Demand Current 

e. Mains 

f. Cooling Estimated Demand Current 

g. Heating Estimated Demand Current 

14. Still on the Fields tab, create some calculated values to help with the calculations.  Select 

Calculated Value button. 

a. Overloaded 

i. Name: Overloaded 

ii. Discipline: Common 

iii. Type: Number 

iv. Formula: Total Estimated Demand Current / Mains 

b. Total Estimated Demand with NC 

i. Name: Total Estimated Demand with NC 

ii. Discipline: Electrical 

iii. Type: Current 

iv. Formula: Total Estimated Demand Current - if(Heating Estimated Demand 

Current > Cooling Estimated Demand Current, Cooling Estimated Demand 

Current, Heating Estimated Demand Current) 
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15. Move the Total Estimated Demand with NC Field to where it is between Total Estimated 

Demand Current and Mains.  

16. Click on the Filter tab, and create filter to isolate electrical panels from transformers.  Create a 

filter using a distinctive trait such as panel name i.e. Panel name does not contain a “T”, Panel 

name begins with, etc 

17. On the Sorting/Grouping tab, sort by Panel Name. 

18.  Click on the Formatting tab, select the following parameters and check the Hidden check box 

a. Cooling Estimated Demand Current 

b. Heating Estimated Demand Current 

c. Overloaded 

19. Select mains and then click on the Conditional Formatting Field to create the test to determine if 

the mains are loaded to more than 80% of the rating. 

20. Select the following: 

a. Field: Overloaded 

b. Test: Greater Than 

c. Value: .8 

d. Background Color: Yellow 

   

 

 



Ways To More Effectively Utilize REVIT For Electrical Design 

Stephanie Elliott, PE – Jacobs Engineering 

 

 15 
 

 

 

21. Select Panel Name and then click on the Conditional Formatting Field to create the test to 

determine if the mains are under-loaded such that the panel mains could be reduced.  Tests for 

a load of less than 40% of the mains rating.  

22. Select the following: 

a. Field: Overloaded 

b. Test: Less Than 

c. Value: .4  

d. Background Color: Cyan 
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23. Click okay.   

 

The calculated value to determine Mains overloading is correct but does not take the non-coincidental 

heating versus cooling diversity. Revit formulas do not play nice with Null or blank values so the 

comparison between the Non-coincidental current and the mains is a manual/ visual comparison by the 

end user. 

Creating a New Transformer Loading Schedule 

1. Go to the view tab and select “Schedules” under the create pane or right click on Schedules on 

the project browser.   

2. Select “New Schedule/ Quantities” 

3. Under category select “ Electrical Equipment” 

4. Select the following Available Field and click Add�: 

a. Panel Name 

b. Total Connected 

c. Total Estimated Demand 

d. Mains 

5. Still on the Fields tab, create some calculated values to help with the calculations.  Select 

Calculated Value button. 

a. Overloaded 

i. Name: Overloaded 

ii. Discipline: Common 

iii. Type: Number 

iv. Formula: Total Estimated Demand Current / Mains 

b. Total Estimated Demand with NC 
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i. Name: Total Estimated Demand with NC 

ii. Discipline: Electrical 

iii. Type: Current 

iv. Formula: Total Estimated Demand Current - if(Heating Estimated Demand 

Current > Cooling Estimated Demand Current, Cooling Estimated Demand 

Current, Heating Estimated Demand Current) 

6. Click on the Filter tab, and create filter to isolate electrical panels from transformers.  Create a 

filter using a distinctive trait such as panel name i.e. Panel name contains a “T”, Panel name 

begins with, etc 

7. On the Sorting/Grouping tab, sort by Panel Name. 

8.  Click on the Formatting tab, select the following parameters and check the Hidden check box 

a. Overloaded 

9. Select mains and then click on the Conditional Formatting Field to create the test to determine if 

the mains are loaded to more than 80% of the rating. 

10. Select the following: 

a. Field: Overloaded 

b. Test: Greater Than 

c. Value: .8 

d. Background Color: Yellow 
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11. Select Panel Name and then click on the Conditional Formatting Field to create the test to 

determine if the mains are under-loaded such that the panel mains could be reduced.  Tests for 

a load of less than 40% of the mains rating.  

12. Select the following: 

e. Field: Overloaded 

f. Test: Less Than 

g. Value: .4  

h. Background Color: Cyan 

 

 

13. Click okay.   

Creating a New Circuit Loading Schedule 

1. Go to the view tab and select “Schedules” under the create pane or right click on Schedules on 

the project browser.   

2. Select “New Schedule/ Quantities” 

3. Under category select “ Electrical Circuits” 

4. Select the following Available Field and click Add�: 

a. Panel Name 

b. Circuit Number 
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c. Load Name 

d. Rating 

e. Apparent Current 

f. Apparent Load 

g. Wire Size 

h. Length 

i. Voltage 

j. Voltage Drop 

5. Still on the Fields tab, create some calculated values to help with the calculations.  Select 

Calculated Value button. 

a. Breaker Loading 

i. Name: Overloaded 

ii. Discipline: Common 

iii. Type: Number 

iv. Formula: Apparent Current / Rating 

6. On the Sorting/Grouping tab, sort by Panel Name. 

7.  Click on the Formatting tab, select the following parameters and check the Hidden check box 

a. Overloaded 

8. Select mains and then click on the Conditional Formatting Field to create the test to determine if 

the mains are loaded to more than 80% of the rating. 

9. Select the following: 

a. Field: Overloaded 

b. Test: Greater Than 

c. Value: .8 

d. Background Color: Yellow 
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10. Select Panel Name and then click on the Conditional Formatting Field to create the test to 

determine if the mains are under-loaded such that the panel mains could be reduced.  Tests for 

a load of less than 40% of the mains rating.  

11. Select the following: 

i. Field: Overloaded 

j. Test: Less Than 

k. Value: .4  

l. Background Color: Cyan 
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12. Click okay.   

I then place all of the three schedules created above on “Z” series sheets to allow them to be printed 

and reviewed by the senior engineer as part of the QA/QC process as well as to make the data available 

to staff who may not work directly in Revit to allow them to benefit from the database mindset as well. 

Utilize view filters to catch un-circuited electrical items as well as other 

disciplines that require power 
 

There are two ways in Revit that electrical items can be considered un-circuited.  One is a little more 

obvious to the drafter/designer than the other.  In Revit, there is both a graphical representation of the 

circuit as well as a “electrical” representation of a circuit.  Filters can be used to check for both types of 

un-circuited items. 

Filters to check for Un-Circuited Items Where no attempt has been made 

To check to see if any attempt has been made to circuit electrical items, create a filter to check if the 

electrical item is associated with a panel.   

1. Go to the Visibility/Graphic Overrides window.  

2. Click on the filters tab.  

3. Select Edit/New… button.  

 

4. Click the new filter button on the button left corner.  (Looks like a piece of paper with a sunburst 

in the corner.) 
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5. Name the filter “CKT to Panel”.  Click ok. 

6. Select the categories this filter should be applied to.  Select “Electrical Fixtures” and “Light 

Fixture”  

 

7. Under Filter Rules: 

a. Filter by “Panel Name”  equals  (blank) 

b. Filter by “Circuit Number” equals (blank) 
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8. Select okay which will return to Visibility/Graphic Overrides window.  

9. Click add and select the filter just created:   “CKT to Panel” 

10. Click the override button under the Lines category and select green as the color.  Select Okay. 

 

  

11. Click okay to exit the Visibility/Graphic Override window.  Revit will think for a minute and then 

all electrical and lighting fixtures that no attempt has been made to circuit will turn green 

making it much easier to find on the drawings.  

 

Filters to check for Un-Circuited Items Where an attempt has been made but no completed 

Sometimes an attempt is made to circuit an item but it is either not successfully completed or 

something else changed to break the circuit.  To check, create a filter to check if the electrical item is 

associated with a circuit.   

1. Go to the Visibility/Graphic Overrides window.  

2. Click on the filters tab.  

3. Select Edit/New… button.  

4. Click the new filter button on the button left corner.  (Looks like a piece of paper with a sunburst 

in the corner.) 

5. Name the filter “CKT to Breaker”.  Click ok. 

6. Select the categories this filter should be applied to.  Select “Electrical Fixtures” and “Light 

Fixture”  

7. Under Filter Rules: 

a. Filter by “Circuit Number” equals (blank) 

8. Select okay which will return to Visibility/Graphic Overrides window.  

9. Click add and select the filter just created:   “CKT to Breaker” 

10. Click the override button under the Lines category and select red as the color.  Select Okay. 

11. Click okay to exit the Visibility/Graphic Override window.  Revit will think for a minute and then 

all electrical and lighting fixtures that have not been successfully connected to a panel and 

circuit breaker will turn red making it much easier to find on the drawings.  
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Conclusion 

Revit requires a mindset shift from being a drafting tool to a database to be manipulated to show the 

data in the formats needed to improve efficiencies and coordination processes.  When this mindset shift 

occurs, we are able to utilize schedules to perform energy code calculations, coordinate electrical 

circuitry with mechanical and plumbing loads, and check electrical design at the panel and breaker level, 

and as well as us view filters to catch un-circuited electrical items as well as other disciplines that require 

power.  With a little bit of set up time in the front end of the project, we are able to save both time and 

money on the backend at the deadline. All of these items allow us to share the information with staff 

not working in Revit as well as improve our quality and deliverable to the client.      


